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Weatherization Information Data System 

Introduction to WIDS 
 The Weatherization Information Data System (WIDS) is a database utilized by both Local Agencies and the Washington State Department of 

Commerce’s(Commerce) Housing Improvements and Preservation Unit in order to report information regarding weatherization projects around the state. The 

Local Agencies use WIDS to provide data about and keep track of weatherization projects, while the state department uses WIDS to provide data regarding 

funding sources and demographics to many different governmental entities. The State Department also uses WIDS as a tool to help monitor the compliance of 

Local Agencies with regards to state and federal policies.  

How to Access the Weatherization Information Data System 
 In order to access WIDS, a member of a Local Agency or Commerce needs to be added to the Organization Details screen by a Security Administrator. Each 

Local Agency has at least one Security Administrator. If you need help determining who your agency’s Security Administrator is, contact the WIDS help desk at 

wids@commerce.wa.gov.  

 After a new user is added to the Organization Details screen, the user needs to set up a Secure Access Washington (SAW) account. If the user already has a 

SAW account, they will need to add the Weatherization Information Data System to their My Services tab. Direction on how to create a SAW account, as well as 

how to add WIDS to a My Services tab can be found here: SAW Setup Account.  

 Once a WIDS user has a SAW account, WIDS can be accessed through the SAW website by clicking on the Weatherization (WIDS) link under the My 

Services tab. If this is the first time accessing WIDS on a computer, or the first time accessing a new version of WIDS, the user may be asked to “run” the 

application. The user will need to allow access for the program to run in order to launch WIDS. (ADD instructions on how to access wids via our website, or some 

way other than through SAW, since SAW has the broken link.  Isn’t the link still broken? And if it is broken, then we need to revise this part so that we don’t 

instruct them to access WIDS via the SAW link. 

  

mailto:wids@commerce.wa.gov
http://www.commerce.wa.gov/DesktopModules/CTEDPublications/CTEDPublicationsView.aspx?tabID=0&ItemID=9171&MId=870&wversion=Staging
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The WIDS User Manual 
 This user manual explains how to add and update multiple types of weatherization projects in WIDS, as well as how to represent several different and 

important project stages in the database. This user manual provides instructions on how to access previously added projects, and how to add new, edit, and save 

Single Family and Multi-Family projects in WIDS. Any additional questions can be sent to the WIDS Help desk, , or through the link provided in the Help drop-down 

at the top of the page. This link will open Outlook and auto-fill the To: field with the WIDS Help Desk E-mail. More information about Commerce and the 

Weatherization Program can also be found through clicking on the About Commerce link the Help drop-down. This link will open the Commerce Home Page. 

  



 
 

5 
 

Project Browse Screen 

Introduction to the Project Browse Screen 
 After opening WIDS, the first screen is the Project Browse screen. If the user navigated away from this screen, the Project Browse screen also can be 

accessed through the Project drop-down menu at the top of the page. Additionally, the screen currently being viewed will be named at the top of each screen. For 

example, the Project Browse screen will have the label, “Weatherization Information Data System (PROD.WX) – [Project Browse]” at the top of the screen 

(However, the example pictures in this user manual will have a slightly modified label compared to the labels at the top of the screen for the production version of 

WIDS used by Local Agencies. In this user manual, the label at the top of the screen will read, “Weatherization Information Data System (QA.WX) – [Project 

Browse].” This difference is caused by using a test version of WIDS, instead of the production version of WIDS, in order to protect confidential information. 
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 Project Browse displays a catalogue of the Local Agency’s saved records. Whenever a record is saved, it is catalogued here.  Use the Project Browse screen 

to find and select a specific project. Use the columns headers to sort or filter the list of projects. 
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 Use the buttons at the top right of the catalogue to refresh the page, clear filters, or open a selected entry for edit.  Refresh the page after a filter is 

cleared to see the entire list of projects, or refresh the page after entering information into one of the filtering fields. Additionally, refreshing the page can be 

achieved by hitting the Enter key on the keyboard after typing into a filtering field. 
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 Next to the refresh, clear, and edit buttons at the top right of the page, there is a small drop-down button. This button allows a user to either copy the 

currently displayed grid to the computer Clip Board in order to paste the grid into a document or to print the grid using the computer’s default printer setting.  
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Additionally, right-clicking the displayed grid will also bring up a pop-up that displays the same options as the buttons above the catalogue: Clear Filter, 

Refresh, Edit, Copy Grid, and Print Grid.  
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 There are a set of buttons at the very top of the screen, next to the Project drop-down menu. These buttons are as follows: New, Edit, Delete, Save, and 

Refresh. However, not all of these buttons are available on the Project Browse screen. On the Project Browse Screen, the following options are available: Edit 

(which opens an existing project so that a user can edit the details of that project), Save, and Refresh. The New (which creates a new project of the same type) and 

Delete (which deletes the information in a highlighted field) are available under an open project. 
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 On the Project Browse screen, there are several different fields to use to sort projects. Some of these fields allow information to be typed directly into the 

field and other fields are drop-down menus that allow selecting from a few options. Data can be entered into all, some, or none of these fields at a time. The types 

of fields displayed on the Project Browse screen will be discussed below.  
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Drop-down Menus 
 Three fields on the Project Browse screen use drop-down menus: Project Type, Status, and Agency. Each of these drop-down menus contains a list of 

terms to search for a specific project record.  
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Project Type  
 In the Project Type drop-down menu, a user can filter by Single Family projects or Multi-Family projects.  
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Status 
 The Status drop-down menu provides a list of options by which to filter project records. One can filter by status to find projects that are saved in a specific 

status category. The options for the Status drop-down are Active, Closed, Completed, Permanently Deferred, Postponed, and Pre-Audit.  
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Agency 
 The Agency drop-down menu allows a user from an agency to see only the records created by that specific agency. However, the Agency drop-down will 

allow Commerce to sort through records from all agencies by choosing a specific agency from the drop-down.  
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Partial Search Fields 
 The following fields are partial search fields on the Project Browse screen: Building#, # of Units, Building Address, Occupant, Owner Name, Agy Project#, 

COM Project#, and Parcel#. A partial search field allows a user to enter any part of the information displayed in a field. The results of a partial search will display all 

of the projects that include the partial data in that particular field.  
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Building#, # of Units, and Building Address 
 These three partial search fields allow a user to enter any part of a building number, any part of a building address, or any number of units in order to 

search for a specific project. The Project Browse screen lists projects by building. This means that if a project contains multiple buildings, each of those buildings 

will be displayed on the Project Browse. 

 



 
 

18 
 

Occupant and Owner Name 
 These partial search fields on the Project Browse screen allow a user to enter any part of a buildingoccupant or owner name. A user can use any 

combination of letters for these two fields. Entering a part or a whole name into either of these fields will display all of the records where the occupant or owner’s 

name matches the desired search criteria. 
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Agy Project# 
 The Agency Project Number is an alphanumerical identification number that a local agency assigns to each project record when creating and saving a 

record. An agency can use any combination of letters and/or numbers. Each agency has its own system for choosing the Agency Project Number. The Agency 

Project Number is also known as the “unique identifier.” Originally, the Agency Project Number was used on the Weekly ARRA Production Report. Entering a part 

or a whole Agency Project Number into this field will display all of the records that match the search criteria. 
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COM Project# 
 The Commerce Project Number is a number assigned to a project by the WIDS application. This number is assigned to a project upon the initial project 

save. The first three digits in this identification number are the Local Agency’s Identification Number. The digits in the Commerce Project Number are chosen by 

the application. Entering a part or a whole Commerce Project Number into this field will display all of the records that match the search criteria. 
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Parcel# 
 A Property Parcel Number, also called an Assessor’s Parcel Number, is a unique identification number assigned to parcels of real property by the tax 

assessor of a particular jurisdiction for purposes of identification and record-keeping. Entering a part or a whole Property Parcel Number into this field will display 

all of the records that match the search criteria. 
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Exact Search Fields 
 The following fields are exact search fields on the Project Browse page: Building Zip and Status Date. 
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Building Zip 
 The Building Zip Code field is not a partial search field. Enter the entire 5-digit zip code in order to search for a project using this field. Entering a 5-digit zip 

code into this field will display all records sharing that zip code. 
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Status Date 
 The Status Date field is not a partial search field. The Status Date is the date that the project last changed statuses.  Enter the entire date in mm/dd/yyyy 

format. Enter just the month and day in mm/dd format, and the search will auto-fill with the current year. Entering a date into this field will display all records 

sharing the search date. 
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Single Family Project 

Introduction to Starting a New Single Family Project 
 The option to start a new Single Family Project can be found under the Project drop-down at the top of the screen. The project will open in a new window. 
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Navigate among multiple open windows (such as the Project Browse screen and the new Single Family Project) by utilizing the Window drop-down at the 

top of the screen.  
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 In a Single Family Project, the first tab is labeled Project Details. Each project contains nine tabs. These tabs are: Project Details, Contacts, Measures, 

Milestone/Status, Demographics, Costs, Audit, Validation, and Attachments. Each of these tabs contains both required and optional fields (except the Attachments 

tab – which is entirely optional). However, to initially save a project, only one tab requires information.   
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Saving a New Single Family Project in the Pre-Audit Status 
 In order to successfully save a Single Family Project, some basic information must be entered into WIDS. The fields required to initially save a project are 

highlighted in yellow on the Project Details tab. Other fields in the application are required as Milestone Dates are entered on the Milestone/Status tab. One can 

save a project in Pre-Audit status after entering data into the yellow highlighted fields .  
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Milestone/Status tab 
 In order to move a project from one status to the next, a required date needs to be entered on the Milestone/Status tab.  On this tab, the required fields 

are highlighted in yellow. The required date field to move a project into the Active status is the Audit Completed date. This is the day that the audit of the 

building(s) was completed. The date required to move a project into the Completed status is the Final inspection passed date. This date indicates that all of the 

work on the project has been completed and inspected. The date required to move a project into the Closed status is the Project Closed date. Entering this date 

into WIDS indicates all bills relating to the building have been paid.  
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 The other date fields on the Milestone/Status tab, such as the SERC Work Completed date field or the Postponed date field, are fields that allow non-

required, but important information to be shared within an agency or between an agency and Commerce.  
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A feature of the Milestone/Status tab is the Project Status History Menu. This menu displays the status changes, the date entered to change the project’s 

particular status, the last person to change the project’s status, and the day the Milestone/Status date was entered. This menu provides a way to track the 

evolution of a project.  
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Validation Tab 
 As previously mentioned, different fields on different tabs will become required as a project progresses through the different status stages. With each 

Milestone Date added to the Milestone/Status tab, more information becomes required. If a user attempts to save a project in order to move it into a new status, 

but some of the required information is missing, WIDS will prompt the user with a Validation Error Message. This message informs the user that required 

information is missing and needs to be added before the project can be moved into the next status. 
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 An important feature of WIDS is the Validation tab. If a user wishes to know what information is required to move the project to the next status, the 

Validation tab lists the required fields, as well as the tab where the fields are located. If a user attempted to save a project  missing required information and 

received a Validation Error Message, then navigate to the Validation tab to determine what data needs to be added to the project. If a user starts a project 

without saving any data and navigates to the Validation tab, a Validation Error Message will be generated.  At any time, if a project refuses to save, navigate to the 

Validation tab in order to troubleshoot why the project is not saving.  
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Saving a Single Family Project in the Active Status 
 After a project has been audited, add data to the WIDS project to move the project into the Active status. To open the specific project for editing, use the 

search field on the Project Browse screen to find the project and either double-click on the project or click the Edit button to open it. 
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 Once the project is opened, navigate to the Milestone/Status tab and enter a date into Audit Completed field in the Effective Date column.  

 



 
 

36 
 

 After entering an Audit Completed date on the Milestone/Status tab, navigate to the Validation tab to view the information that is required to move the 

project from the Pre-Audit status to the Active status. The following fields (with tab where that particular field is located) are required in order to save the project 

as an Active project: Is ARRA? (Project Details tab), Owner Contact (Contacts tab), Auditor Contact (Contacts tab), Audit Tool (Audit tab), Blower Door (pre) (Audit 

tab), Building Airflow Standard (BAS) (Audit tab).  
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The Is ARRA? field, located on the Project Details tab, is a drop-down menu in which the user must choose either a ‘Yes’ or a ‘No.’ If ‘Yes’ is entered into this field, 

it is required that cost information be entered into the ARRA field on the Costs tab. After the user fills in the Is ARRA? field and the ARRA cost information, the 

application automatically removes this field from the Validation tab. 
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 The next two pieces of required information, both located on the Contacts tab, are the Owner Contact and the Auditor Contact. 
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 In order to add an auditor, first choose a name from the Contacts from your Organization drop-down and then click the Add to Contacts button. This 

contact and related information will be added to the grid in the middle of the page. Then, the user should choose ‘Auditor’ from the Contact Type drop-down 

menu. In order for a contact’s name to appear on the Contacts from your Organization list, the Security Administrator must first add the contact to the 

Organization Details page.  
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 To add the Owner Contact, use the drop-down menu on the Project Specific Contacts grid. Choose the ‘Owner’ option. The remaining fields on this grid are 

type-able fields in order for the user to enter the information of the person who owns the building that is being weatherized. As required fields are being filled on 

the Contacts tab, these fields are automatically removed from the Validation tab. 
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 The final three pieces of information required to move the project into the Active status are located on the Audit tab. The fields required are Audit Tool, 

Blower Door (pre), and Building Airflow Standard. Select an option for the audit tool used from the drop-down menu for the Audit Tool field. The Blower Door (pre) 

and Building Airflow Standard fields are type-able fields. Once a project has been saved in the Active status, the name of the Auditor will appear in the Auditor 

table. 
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 After entering all required information to move a project from the Pre-Audit status to the Active status, save the project using the Save button at the top 

of the screen. Verify  the project is in the Active status using either of the following ways: 1)navigate to the Validation tab and read the Current Project Status 

under the Validation Details grid; or 
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2) navigate to the Milestone/Status tab and verify that the most recent change in project status was the move from Pre-Audit to Active under the Project 

Status History grid. 
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Saving a Single Family Project in the Completed Status 
 After work on a project has been completed and inspected, add data to the WIDS project to move the project into Completed status. To open the specific 

project for editing, use the search field on the Project Browse screen to find the project and either double-click on the project or click the Edit button to open it. 
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 Once the project is opened, navigate to the Milestone/Status tab and enter a date into Final inspection passed field in the Effective Date column. 
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After entering a Final inspection passed date on the Milestone/Status tab, navigate to the Validation tab to view the information required to move the 

project from the Active status to the Completed status. The following information (with tab where that particular piece of information is located) are required in 

order to save the project as a Completed project: Electricity Utility (Project Details tab), Primary Heat Source (Project Details tab), Housing Status (Project Details 

tab), Combustion Appliance (Project Details tab), Meter Type (Project Details tab), Construction Funding Type (Project Details tab), Year Built (Project Details tab), 

Inspector Contact (Contacts tab), Contractor Contact (Contacts tab), at least one Building Measure (Measures tab), three different Demographic Counts 

(Demographics tab), a detailed account of Project Costs (Costs tab), and Blower Door (post) (Audit tab). 
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 The picture below displays where the required fields are on the Project Details tab. The Electricity Utility and Primary Heat Utility fields are both drop-

down fields. The Year Built field is a type-able field where the user must enter the date that building was built. The four remaining fields (Combustion Appliance, 

Construction Funding Type, Housing Status, and Meter Type) that are required on the Project Details tab in order to move the project in the Completed status are 

located in the Building Characteristics grid on the right-hand side of the screen. These four fields require one box to be checked for each category.  
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 The next tab that requires information to save the project in the Completed status is the Contacts tab. To add a Contractor Contact, add a contact from 

the Contacts from your Organization drop-down to the grid. Then use the Contact Type drop-down in order to choose “Contractor” from the list. The contact 

information for the person chosen is automatically filled into the rest of this grid by the application. 
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To add an Inspector Contact, add a contact from the Contacts from your Organization drop-down to the grid. Then use the Contact Type drop-down in 

order to choose “Inspector” from the list. The contact information for the person chosen is automatically filled into the rest of this grid by the application. 

 



 
 

50 
 

 The next tab requiring information in order to move the project into the Completed status is the Measures tab. On this tab, there is a list of measures 

(Measure column) sorted by different measure categories (Measure Category). The user must enter as least one measure in this tab. 
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On the Measures tab, there is a column labeled Unit of Measure that describes how to indicatethat a particular measure was used in the building. For 

some measures, in order to display a particular measure was used, the user must enter a “1” into the Qty column. In this case, 1 represents “Yes” for “Yes, this 

measure was performed.” Other measures require that the user enter a quantity amount for how many of that particular measure were completed. Additionally, 

there are some measures that require the user to enter the square foot amount of the measure installed, as well as the R/U-value change. The R/U- value change 

amount should be entered into the R/U Value Chg column. This column allows data entry only when a particular measure requires an R/U-value change.  
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 On the Measures tab, there is a column labeled Wx Specification. If there are any questions regarding the specifications, please refer to the Specifications 

and Standards section of the Department of Commerce’s Weatherization Manual. The Wx Specification column lists which specifications are associated with each 

measure. Hovering the mouse over a row in the Wx Specification column will cause  a pop-up that includes keywords for the specifications associated with that 

measure. 
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The next tab that requires data entry in order to move the project in the Completed status is the Demographics tab. On this tab, the user needs to indicate 

number of units by income levels and number of people served. Additionally, the user needs to indicate on this sub-tab the number of units that contained people 

within certain age ranges and how many people were in those ranges. 
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As only 66% of the people being served in the units need to be income qualified, data does not need to be collected about all the units in some Multi-

Family projects. To indicate that information was not gathered about all of the units, there is a field to indicate how many units were not surveyed. This field is 

labeled Unknown. 
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Additionally, one of the validation messages from the Validation Messages table states that the Total # of Units Weatherized (which is a field that auto-fills 

with the sum of the number of units from the Income Level section of the Demographics tab and the Not Weatherized Section of the Demographics tab) must 

equal the # of Units in Building field on the Project Details tab, Basic/Characteristics sub-tab.  
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 To move a project into the Completed status, data about costs for this project needs to be entered. However, if at this point in time, the user does not 

know the specific funding sources, the dollar amounts can be placed in the Unassigned field of the Costs tab. Any costs entered in the Unassigned field will need to 

be distributed to specific funding sources before the project can be moved into the Closed status.  
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If a ‘Yes’ was entered into the Is ARRA? field on the Project Details tab, thencost amounts need to be entered in the ARRA field on the costs table. 

 



 
 

58 
 

When entering costs on the Costs tab, the project costs must be distributed among the different categories as appropriate. These categories are 

associated with the measure categories found on the Measures tab. If a measure is entered for a project, the associated cost must be entered on the Costs tab in 

the proper category. For example, if a Health and Safety measure is entered on the Measures tab, then the associated cost for performing that measure must be 

entered in the Health and Safety cost column on the Costs tab for the appropriate funding source. 
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The Project Costs (Historical Snapshot) provides a history of the Costs tab. It allows the user, a local agency, and Commerce to see when the Costs tab was 

altered and it what way it was altered. 
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The final tab requiring data entry to move the project into the Completed status is the Audit tab. On this tab, in the Blower Door (post) field, fill in the 

results of the Blower Door Test after the weatherization measures were installed . 
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After filling in all required information to move the project into the Completed status, save the project and then navigate back to the Validation tab to 

verify that all of the required information has been entered (which will mean that there are no more Validation Messages listed in the table) and that the project 

has been moved into Completed status. This will be displayed in the Validation Details table.  
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Saving a Single Family Project in the Closed Status 
After all payments on the project are made, add information into WIDS to move the project into the Closed status. To open the specific project for editing, 

use the search field on the Project Browse screen to find the project and either double-click on the project or click the Edit button to open it. 
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Once the project has been opened, navigate to the Milestone/Status tab and enter a date into Project Closed field in the Effective Date column. 
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After entering a date into the Project Closed field, navigate to the Validation tab to view the information that is required to move the project from the 

Completed status to the Closed status. The following information (with tab where that particular piece of information is located) is required in order to save the 

project as a Closed project: Unassigned Costs (Costs tab). 
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In order to move the project into the Closed status, any costs originally entered and remaining in the Unassigned field on the Costs tab will need to be 

removed and amounts will need to be assigned to specific funding sources. 
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After entering the required cost information, save the project and navigate back to the Validation tab. In order to save the project and move it into the 

Closed status, there should be no messages remaining in the Validation Messages Table. If there are no remaining messages, the project should have been moved 

into the Closed status. This will be displayed in the Validation Details table. 
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Multi-Family Project 

Introduction to Starting a New Multi-Family Project 
 The option to start a new Multi-Family Project can be found under the Project drop-down at the top of the screen. The project will open in a new window. 
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Opening a new Single Family Project will bring a user to the first tab of the project. This tab is labeled Project Details. Each project contains six tabs. These 

tabs are: Project Details, Contacts, Milestone/Status, Cost Summary, Validation, and Attachments. Each of these tabs contains both required and optional fields 

(except the Attachments tab – which is entirely optional). However, to initially save a project, only one tab requires information.   
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Additionally, each building added to a Multi-Family project will have its own set of six tabs. These tabs are: Basics/Characteristics, Audit, Building 

Milestones, Measures, Demographics, and Costs. Each of these tabs contains both required and optional fields, however, only one of these building specific tabs 

requires information to initially save the project.  
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Saving a New Multi-Family Project in the Pre-Audit Status 
 In order to successfully save a new Single Family Project, basic information must be entered into WIDS. These required fields are  located on the Project 

Details tab and its sub-tab, Basics/Characteristics, and are highlighted in yellow. Other fields in the application will become required as Milestone Dates are 

entered on the Milestone/Status tab, however, to initially create a record, these yellow highlighted fields are the only fields which require data. Entering data into 

just these yellow highlighted fields will save the new Multi-Family Project in the Pre-Audit status.  
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Saving a Multi-Family Project in the Active Status 
 After a project has been audited, add more data to the project in WIDS  to move the project into the Active status. To open the specific project for editing, 

use the search field on the Project Browse screen to find the project and either double-click on the project or click the Edit button to open it. 
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 Once the project has been opened, navigate to the Milestone/Status tab and enter a date into Audit Completed field in the Effective Date column.  
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 Additionally, navigate to the Project Details tab, and then the Building Milestones sub-tab, and enter an Audit Completed date for each building that has 

been added to the project. How to add multiple buildings to Multi-Family projects will be addressed later in this manual. 
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 After entering an Audit Completed date on the Milestone/Status tab, navigate to the Validation tab to view the information required to move the project 

from the Pre-Audit status to the Active status. The Validation tab informs the user on what tab each piece of necessary information is located. The following fields 

(with tab where that particular field is located) are required in order to save the project as an Active project: Is ARRA? (Project Details tab), Audit Tool (Project 

Details tab), Owner Contact (Contacts tab), and Auditor Contact (Contacts tab). 
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The Is ARRA? field, located on the Project Details tab, is a drop-down menu in which the user must choose either a ‘Yes’ or a ‘No.’ If ‘Yes’ is entered into 

this field, it be required that cost information be entered into the ARRA field on the Costs tab for each specific building. After the user fills in the Is ARRA? field and 

the ARRA cost information, the application automatically removes this field from the Validation tab. 
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 The next required field to move the project into the Active status is the Audit Tool field. This field is located on the Project Details tab, Audit sub-tab. To 

enter the audit tool used, choose an option from the Audit Tool drop-down. 
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The next two pieces of required information, both located on the Contacts tab, are the Owner Contact and the Auditor Contact. 
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 In order to add an auditor, first choose a name from the Contacts from your Organization drop-down and then click the Add to Contacts button. This 

contact and related information will be added to the grid in the middle of the page. Then, choose ‘Auditor’ from the Contact Type drop-down menu. In order for a 

contact’s name to appear on the Contacts from your Organization list, the Security Administrator must first add the contact to the Organization Details page.  
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 To add the Owner Contact, use the drop-down menu on the Project Specific Contacts grid to choose the ‘Owner’ option. The remaining fields on this grid 

are type-able fields to enter the information of the person who owns the subject building. As required fields are filled in on the Contacts tab, these fields are 

automatically removed from the Validation tab. 
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 After filling in the required information, save the project and navigate back to the Validation tab. The Validation Details table will confirm if the project has 

been properly moved in the Active status. 
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Saving a Multi-Family Project in the Completed Status 
After the work on a project has been completed and inspected, add data to the WIDS project to move the project into the Completed status. However, 

before a project can be moved into the Completed status, each building within that project has to be moved into the Completed status. Each building within a 

project has required information and its own set of validation messages.  To open the specific building for editing, use the search field on the Project Browse 

screen to find the building and either double-click on the project or click the Edit button to open it. 
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Moving a Building in a Multi-Family Project to the Completed Status  

Once the project has been opened, navigate to the Project Details tab and enter a date into Final inspection passed field in the Effective Date column of 

the building specific Building Milestone sub-tab. 
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After entering a Final inspection passed date on the Building Milestone tab, navigate to the Validation tab to view the information required to move the 

building from the Active status to the Completed status. The following pieces of information (with tab where that particular piece of information is located) are 

required to save the project as a Completed project: Housing Status (Project Details tab, Basics/Characteristics sub-tab), Combustion Appliance (Project Details 

tab, Basics/Characteristics sub-tab), Construction Funding Type (Project Details tab, Basics/Characteristics sub-tab), Meter Type (Project Details tab, 

Basics/Characteristics sub-tab), Primary Heat Source (Project Details tab, Basics/Characteristics sub-tab), Year Built (Project Details tab, Basics/Characteristics sub-

tab), Audit Tool (Project Details tab, Audit sub-tab), Building Measures (Project Details tab, Measures sub-tab), Demographics Count Age Range - # People (Project 

Details tab, Demographics sub-tab), Demographics Count Age Range - # Units (Project Details tab, Demographics sub-tab), Demographic Count for Income Level # 

Units plus Not Weatherized must match Building Detail # of Units in Building (Project Details tab, Income Level # Units and Not Weatherized located on 

Demographics sub-tab, # of Units in Building located on Basics/Characteristics sub-tab), and Building Costs (Project Details tab, Costs sub-tab).
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All of the required data to move the building into the Completed status is the Project Details tab on various sub-tabs. The first sub-tab requiring data entry 

is the Basics/Characteristics sub-tab. The picture below displays all of the required fields on the Project Details tab, Basics/Characteristics sub-tab. Housing Status, 

Combustion Appliance, Construction Funding Type, and Meter Type are all located on the Building Characteristics grid. These four fields are all check boxes. The 

user should check one answer for each of these fields. Primary Heat and Year Built are both located under the Building Detail on the Basics/Characteristics sub-

tab. The Primary Heat consists of two drop-down menus. Here, select the heat type and the heat provider from the drop-down menus. Year Built is a type-able 

field. The user should enter a 4-digit year in this field. 
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 Next, navigate to the Measures sub-tab. Enter at least one measure on this tab in order to remove this message from the Validation Messages table.  
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On the Measures tab, there is a column labeled Unit of Measure that informs the proper way of indicating that that particular measure was used in the 

weatherization of this building. For some measures, in order to display that this particular measure was used, the user has to enter a “1” into the Qty column. In 

this case, 1 represents “Yes” for “Yes, this measure was performed.” Other measures require that the user enter a quantity amount for how many of that 

particular measure were completed. Additionally, there are some measures that require the user to enter the square foot amount of the measure installed, as 

well as the R/U-value change. The R/U- value change amount should be entered into the R/U Value Chg column. This column allows data entry only when a 

particular measure requires an R/U-value change.  
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The next sub-tab that requires data entry in order for the building to be moved into the Completed status is the Demographics sub-tab. On this sub-tab, 

indicate how many units were categorized in which income levels and how many people were served. Additionally, the user needs to indicate on this sub-tab the 

number of units that housed people within certain age ranges and how many people were in those ranges. 
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 As only 66% of the people being served in the units need to be income qualified, data does not need to be collected about all the units in some Multi-

Family projects. To indicate that information was not gathered about all of the units, there is an additional data entry fields to indicate how many units were not 

surveyed. This field, labeled Unknown allows the user to indicate that not all of the units were surveyed. Note the Total # of Units Weatherized field (which is 

automatically propagated based on the number of units entered into the different income ranges) needs to equal the total number of units in the building 

(located on the Project Details tab). 
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Additionally, one of the validation messages from the Validation Messages table states that the Total # of Units Weatherized (which is a field that auto-fills 

with the sum of the number of units from the Income Level section of the Demographics tab and the Not Weatherized section of the Demographics tab) must 

equal the # of Units in Building field on the Project Details tab, Basic/Characteristics sub-tab. In a Multi-Family Project, if not all of the units were weatherized, the 

user needs to indicate how many units were not weatherized in the Not Weatherized field.  
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The next sub-tab requiring data entry is the Costs sub-tab. Navigate to the Costs sub-tab, while still on the Project Details tab and enter building specific 

costs. Costs for each building must be entered before the entire project can be moved into the Completed status. However, at this point, it is not necessary for 

costs to be distributed to specific funding sources. If, at this point, the user does not know how the project costs will be distributed among funding sources, 

amounts can be entered into the Unassigned field. Any costs entered into this field will need to be distributed to specific funding sources before the project can 

be moved in to the Closed status.  
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Each of these fields needs to be entered for each, individual building before the entire project can be moved in the Completed status. Each building needs 

its own costs, demographics counts, measures, audit tool, year built, primary heat type and provider, and basic building characteristics added.  
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Moving a Multi-Family Project to the Completed Status  

 Once all of the required information has been entered to move each of the buildings to the Completed status, the entire project can be saved as 

Completed. Before the project is moved the new status, there is some information required on the project level. Once the project has been opened, navigate to 

the Milestone/Status tab and enter a date into Final inspection passed field in the Effective Date column. 
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After entering a Final inspection passed date on the Milestone/Status tab, navigate to the Validation tab to view the information required to move the 

project from the Active status to the Completed status. The following information (with tab where that particular piece of information is located) is required in 

order to save the project as a Completed project: Electricity Utility (Project Details tab), Contact (Contacts tab), and Contractor Contact (Contacts tab). 
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 To enter the first piece of information required to move the entire project into the Completed status, navigate to the Project Details tab to enter the 

Electricity Utility. The Electricity Utility field is a drop-down field; choose a utility company from the list. Entering this piece of required information will remove 

this entry from the Validation Messages Table. 
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 The next tab requiring information before the project can be moved into the Completed status is the Contacts tab.  Assign an Inspector and a Contractor 

for the entire project. If there are multiple contractors and inspectors working on this Multi-Family project, enter all of the inspectors and contractors. 
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To add a Contractor Contact, first add a contact from the Contacts from your Organization drop-down to the grid. Then use the Contact Type drop-down in 

order to choose “Contractor” from the list. The contact information for the person chosen is automatically filled into the rest of this grid by the application. 
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To add an Inspector Contact, first add a contact from the Contacts from your Organization drop-down to the grid. Then use the Contact Type drop-down in 

order to choose “Inspector” from the list. The contact information for the person chosen is automatically filled into the rest of this grid by the application. If a 

name of an inspector or contractor is missing from the Contacts from your Organization drop-down, the Security Administrator will need to add the contact.  
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After entering the contact information, navigate back to the Validations tab to verify that all of the validation messages have been cleared from the 

Validation Messages table. After saving, the Milestone/Status page should verify that the Multi-Family project has been moved into the Completed status. 
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Saving a Multi-Family Project in the Closed Status 
After all payments on the project are made, the next step is to add information into WIDS in order to move the project into the Closed status. To open the 

specific project for editing, use the search field on the Project Browse screen to find the project and either double-click on the project or click the Edit button to 

open it. 
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Once the project has been opened, navigate to the Milestone/Status tab and enter a date into Project Closed field in the Effective Date column. 
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After entering a date into the Project Closed field, navigate to the Validation tab to view the information required to move the project from the 

Completed status to the Closed status. The following information (with tab where that particular piece of information is located) is required in order to save the 

project as a Closed project: Unassigned Costs (Costs tab). 

 



 
 

102 
 

In order to move the project into the Closed status, any amounts originally entered and remaining in the Unassigned field on the Costs tab will need to be 

removed and amounts will need to be assigned to specific funding sources. 
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After entering the required cost information, save the project and navigate back to the Validation tab. In order to save the project and move it into the 

Closed status, there should be no messages remaining in the Validation Messages Table. If there are no remaining messages, the project should have been moved 

into the Closed status. This will be displayed in the Validation Details table. 
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Cost Summary Tab 
 The Cost Summary tab is available only on Multi-Family Projects. The Cost Summary tab provides a summary for all of the funds allocated in the individual 

building’s Costs tabs. This tab is read-only. 
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 Another feature of the Costs Summary tab is the Historical Snapshots drop-down menu. If changes are made to the costs of a project, these changes are 

captured in this drop-down menu. These changes are available in the drop-down menu after the changes have been in the system for a 24-hour period. This tool is 

helpful to help track the changes that have been made to a project over time and how much is spent from various funding sources.  
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 However, if changes are made to a building’s Costs sub-tab after the project has already been closed, a comment is required in order to save the changes. 

The field for comments is located to the right of the Cost Total column on the Costs sub-tab.  

 



 
 

107 
 

Adding Buildings to a Multi-Family Project 
 In order to add buildings to a Multi-Family Project, a valid project record must be created by entering all of the initial information required in order to save 

the project in the Pre-Audit status. After saving a Multi-Family project in the Pre-Audit status, individual building records can be added to the project record. 

There are two different way to add individual buildings to a project.  
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 The first way to add a building to a Multi-Family project is by creating a new building record. This method is desirable if the information in this new 

building record is different than the initial building record in the project. To add an entirely new building to Multi-Family project record, click on the New Building 

button. A new record will appear and will allow you the opportunity to enter new building information. 
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 After a new building has been created and saved with information entered into the yellow highlighted fields, it will be displayed in the Select a Building 

table. This table is where all of the individual building records for a project may be accessed. 
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 The second way to add a new building to a Multi-Family project is to copy an existing building record. This method is desirable if the new building being 

created has the same baseline information an existing building record. To copy an existing building record, highlight the building in the Select a Building table that 

will provide the baseline information. Then, enter the number of copies desired in the blank field directly next to the Copy Building button and then click the Copy 

Building button.  
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 Once the Copy Building button has been clicked, a message will pop up asking it the information entered is correct. If the information entered is correct, 

click ‘Yes’ to continue. 
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 After clicking ‘Yes,’ another pop-up will appear. This pop-up informs the user of the action that was just taken by the application.  
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 After the user clicks ‘OK,” the new building will be displayed in the Select a Building table. In order to identify the new building from the original, WIDS will 

have added “.1” to the building number of the original and entered that into the Building# field of the new building.  
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 To make changes to buildings, click on the building record in the Select a building table. Be certain to save a record before switching to a new building 

record, otherwise any changes made will not be saved.  
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 Each building created will have its own set of sub-tabs.  
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 Additionally, each building will require its own Audit completed date and Final Inspection passed date. All buildings will need an Audit date added before 

the entire project can be moved into the Active status. Also, each building will need to have a Final Inspection passed date added before the entire project can be 

moved into the Completed status. 

 


